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Toolkit for Participatory Coastal Spatial Planning at the 
District Level
The Government of Vietnam is highly interested in improving coastal forest management, 
especially for mangrove forests. Decree 119/2016/ND-CP, approved by the Government of 
Vietnam in August 2016, focuses on policies for the sustainable management, protection, and 
development of coastal forests to support adaptation to climate change.

The Our Coast – Our Future pilot project2 promotes the design of coastal spatial scenarios and a 
spatial implementation plan as part of a participatory coastal spatial planning process that enables 
the adoption of a holistic approach to coastal forest management. By working with coastal 
communes, the creation of a district-level spatial implementation plan enables coordination and 
consensus over how to manage the coastal landscape to achieve the sustainable management of 
coastal forests.

The development of coastal spatial scenarios explicitly considers the relationship between forest 
rehabilitation and management, and multiple other uses of the coastal landscape for infrastructure, 
livelihood	support,	and	income	generation.	By	identifying	the	complementarities	and	conflicts	
between these different current and future interests in the coastal landscape, an integrated coastal 
resource management approach can be set into motion. 

This Toolkit for Participatory Coastal Spatial Planning at the District Level promotes a 
tenure-responsive form of coastal spatial planning by identifying ways to improve the sustainability 
of coastal natural resources focusing on issues of access, use, management, and exclusion rights to 
specific	resource	areas.	Once	a	spatial	implementation	is	developed,	the	stage	is	set	for	creating	
a collaborative approach to mangrove management with key local stakeholders. Altogether, this 
provides an effective way of improving the sustainable management of vital coastal resources such 
as mangrove forests. 

The Toolkit for Participatory Coastal Spatial Planning at the District Level is composed 
of three parts:

a. Guide	No.	1:	Participatory	Coastal	Resource	Assessment:	Developing	Commune	Coastal	Profiles	in	
Vietnam.

b. Guide No. 2: Participatory Mapping: Creating Knowledge for Coastal Spatial Planning in Vietnam.

c. Guide No. 3: Building Coastal Spatial Scenarios in Vietnam: Supporting Planning in Coastal 
Landscapes at the Local Level.

These guides are available in both Vietnamese and English languages.

2 This pilot was developed and implemented through the Tenure and Global Climate Change (TGCC) Program. See: 
https://www.land-links.org/project/tenure-global-climate-change-vietnam/.

https://www.land-links.org/project/tenure-global-climate-change-vietnam/


1. Introduction
1.1 Purpose: Mapping Vietnam’s Coastal Landscapes at the District 

Level

In Vietnam, many organizations and communities have worked with the local government to 
increase mangrove forest areas and build a coastal buffer that protects their coastlines. These 
efforts to expand mangrove areas have been largely successful. Mangroves support local aquatic 
productivity and help with both adaptation and mitigation measures in the face of climate change. 
In the face of growing global and national recognition of the importance of mangrove forests, 
the Government of Vietnam issued the Decree No. 119/2016/ND-CP in August 2016 in order to 
provide policies on sustainable management, protection, and development of coastal forests to 
support adaptation to climate change.

In designing approaches to protect and increase coastal forests such as mangroves, it is essential 
to develop an integrated and inclusive approach to mangrove forest management that considers 
unique characteristics not involved with terrestrial forest management. The complexity of 
mangrove and other coastal forest ecosystems requires a careful understanding of not only the 
ecological dynamics but also the diverse types of resource uses communities make within such 
landscapes as well as how they are managed. In the Our Coast – Our Future pilot project, Guide No. 
1 of the Toolkit on Participatory Coastal Spatial Planning at the District Level helps 
communities and the local government carry out a Participatory Coastal Resource Assessment 
(PCRA) so that an analysis of the resource types, conditions, users, and governance and tenure 
arrangements can be developed. This knowledge is presented in the form of a Commune Coastal 
Profile,	which	provides	a	detailed	understanding	of	the	current	conditions	within	the	coastal	
landscape in order to develop spatial visions and scenarios for the future. Some of this knowledge 
is best collected and visualized in a geospatial form so that the question of who is using which 
resources	in	specific	locations	becomes	clearer.

Guide No. 2 focuses on this participatory mapping component. A set of digitized maps are 
prepared	on	identified	themes	to	support	the	participatory	process	for	identifying	a	set	of	
spatial scenarios for the future. Where such digitized maps can be prepared, they become part 
of	the	Commune	Coastal	Profile	created	with	the	help	of	Guide No. 1. Based on the knowledge 
generated from Guides No. 1 and 2, the next step focuses on how to develop an overall 
spatial vision and scenario for the local coastal landscape. This involves identifying a range of 
alternative spatial scenarios from which one spatial scenario is selected for developing a spatial 
implementation plan. This is covered by Guide No. 3: Building Coastal Spatial Scenarios in Vietnam. 

By following these three sequential guides, the best way to manage the local coastal landscape 
through a holistic understanding of the interactions between different livelihoods, economic 
development,	and	forest	conservation	needs	can	be	identified.	Through	such	an	integrated	
approach, the likelihood of implementing successful interventions is increased. Such a coastal 
spatial planning process also provides the framework within which the design of mangrove 
management can be carried out. 
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While Vietnam has been actively engaged in marine or coastal spatial planning at the provincial 
level, the task of developing detailed, district-level management plans for coastal areas works 
best by drawing on the multiple forms of knowledge of local residents and stakeholders at the 
commune and district levels through a participatory approach. This engagement is important 
for four reasons: 1) local community knowledge is interlinked with remote sensing knowledge 
about the coastal landscape, 2) future visions and scenarios for the coastal landscape scale are 
developed through participation from all affected coastal resource user groups, 3) implementation 
of interventions becomes effective through active decision-making among all stakeholders, and 4) 
local data collectors are trained so they can continue to collect information that helps to monitor 
and update progress in the future.

This document (Guide No. 2) provides step-by-step information on creating a set of digitized maps 
through a participatory, low-cost, and rapid process for obtaining key information on the resource 
types, conditions, users, and governance and tenure arrangements within the coastal landscape 
at the commune and district levels. Where it is possible, gender-differentiated information is also 
collected. The aim is to ensure all key groups of users and managers of the local coastal landscape 
are involved in contributing to the collection and validation process of the geospatial data. 

1.2	Mapping	for	the	Commune	Coastal	Profile

For communities living in coastal bays, the local environment not only supports their livelihoods 
but also provides a cultural space within which generations of families have grown up. There 
is often a deep sense of appreciation for the local waters and mangrove forests that form part 
of	their	home.	Mothers	have	taught	their	children	to	glean	within	the	mangroves	and	mudflats,	
and	fathers	have	taught	children	to	fish	by	traps,	nets,	or	boats.	As	the	economy	changes,	
dependencies on the local resources will adjust over time; some will engage in seasonal migration 
for work in larger cities, some will look for local wage labor opportunities, and others will 
develop their own new businesses. Women will increasingly become owners or workers in 
new	commercial	enterprises	such	as	aquaculture,	fishing,	and	clam	farming.3 As the transition in 
economic and ecological conditions takes place, coastal spatial mapping and planning can help 
ensure	that	the	economic	and	environmental	benefits	local	communities	enjoy	today	and	in	the	
future can be properly supported. 

In any given coastal landscape with coastal forests such as mangroves, there are multiple types of 
users drawing upon varied aquatic and land-based natural resources to maintain their food needs 
and generate income.	The	coastal	forests	and	their	associated	ecological	areas	such	as	mudflats,	
seagrass beds, and reefs contribute to ecological wellbeing and the richness and diversity of the 
local resource supply. Mangrove forests, for example, not only protect the coastal infrastructure and 
lands from storms and sea-level rise, but also provide the nutrients and habitat for a wide range of 

3 See two briefs prepared by the Our Coast – Our Future project: a) Why gender matters in sustainable coastal resource 
management within Vietnam’s coastal mangrove forests, and b) Positive steps towards gender equality in participatory 
coastal spatial planning. Case of Tien Lang district, Haiphong, Vietnam. Available at: https://www.land-links.org/
project/tenure-global-climate-change-vietnam/

http://nks.org/project/tenure-global-climate-change-vietnam/
http://nks.org/project/tenure-global-climate-change-vietnam/


aquatic	species	such	as	fish,	shrimp,	crabs,	and	worms	that	form	part	of	the	local	diet	and	provide	
income-generation opportunities.

Expert knowledge alone cannot allow us to understand this complexity of coastal landscapes. 
The	people	who	live	in	the	area	and	who	regularly	glean,	fish,	and	raise	shrimp	have	detailed	
knowledge of the changes over time both during an annual cycle and over the course of years. 
In order to improve livelihoods and protect coastal forests, the condition of the resources as 
well as the governance and tenure arrangements involved in managing these resources needs to 
be understood. Participatory mapping is a process that relies on low-cost, rapid, and accessible 
ways	of	collecting	data	from	local	residents	in	order	to	prepare	a	set	of	digitized	maps	on	specific	
identified	themes.

Once this geospatial 
knowledge is available, the 
process of deciding on both 
the future coastal spatial 
scenarios over the next few 
years and the longer-term 
vision can begin. There are 
many questions to consider 
while developing coastal 
spatial scenarios, including: 
To what extent should 
aquaculture pond areas be 
allowed to expand? In which 
areas can mangrove forests 
be extended? How should 
the disputes between clam-
farming operations and 
fisherfolk	be	resolved?	And	
how can growth in mangrove 
areas support eco-tourism? 
Once a scenario is selected 
and has been agreed to, the 
details of how to manage 
mangrove forests or organize 
clam farming can be focused 
on so that an integrated 
approach is set into motion. 
Maps form an essential 
component of the knowledge 
base for making such 
decisions about the future.

Figure 1: A digitized map showing the location of aquaculture ponds and 
the contract conditions across Tien Lang district’s coastline
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1.3 Key Components of Local Participatory Mapping for Coastal 
Landscapes

Most people living within communes have seen the formal maps available at the commune and 
district levels that contain basic information about the administrative boundaries and key features 
of the landscape. To manage the coastal landscape (particularly the mangrove forests) sustainably, 
more detailed information is needed about the location of the diverse types of natural resources 
and their condition, different types of users, and various governance and tenure arrangements 
that affect the design of an integrated management approach for effective resource regulation. 

The geospatial dimensions of this information can be collected through a participatory mapping 
approach where local residents and key stakeholders become part of the data collection team 
and provide information on prevailing coastal conditions. Participatory mapping is a decentralized 
approach that provides rich data to support coastal resource planning and mapping. Importantly, it 
relies on near real-time data. Such a participatory local approach has been shown to be a cost-
efficient	approach	for	creating	multiple	layers	of	spatial	data	on	the	key	characteristics	of	coastal	
landscape conditions.

This guide shows how participatory mapping utilizes mobile tools, such as global positioning 
system (GPS)-enabled tablets, and open source software in order to quickly and cheaply collect 
data through engagement of key resource users and managers to obtain a wide range of geospatial 
data.	The	collected	geospatial	information	reflects	the	unique	social	and	cultural	understanding	of	
the local landscape among residents.

The preparation of a set of digitized maps through a participatory mapping approach requires 
careful thinking about the types of maps that need to be prepared; how data is collected to create 
such maps; how data collectors are to be trained; and how data will be analyzed, validated, and 
presented. Effective facilitation of each of these steps is critical for the successful completion of 
each step so that the process can produce reliable data.

1.4 Filling in the Picture: Types of Data to be Collected

At the outset of the participatory mapping process, it is important for the core team to work 
together with local district and commune governments, mass organizations, local resource 
users, and other relevant stakeholders to identify what kind of data is necessary for developing 
a coastal spatial implementation plan for their district. In essence, the digitized maps produce a 
supplementary	set	of	geospatial	data	that	fills	out	the	picture	created	through	the	PCRA	process	
(by using Guide No. 1),	and	ultimately	become	a	part	of	the	Commune	Coastal	Profile.	

A facilitated set of meetings with each of these local groups can help collate the key themes that 
maps	should	cover.	These	can	then	be	distilled	down	to	a	finalized	set	of	digitized	data	and	maps	
to be prepared. It will be important to determine the geographical boundaries for the maps, 
including deciding, for example, if the area in front of sea dikes will be covered and how far out 



from the coast the map will cover. In addition, it is necessary to identify which types of spatial and 
non-spatial data (such as photographs) will be collected for the creation of each map.

To guide this discussion, it is suggested that the individual maps cover the following key themes:

1. Broad coastal resource types:	aquaculture	ponds,	mangrove	areas,	mudflats,	fishing	by	
net	areas,	fishing	by	boat	areas,	and	clam	farming.

2. Mangroves and coastal forests: details of areas covered by older and younger mangrove 
forests (natural and planted) and proposed rehabilitation areas.

3. Pollution	and	conflict	areas:	areas	where	conflicts	exist	between	specific	types	of	
resource	users,	such	as	conflicts	between	boat	fisherfolk	and	clam	farmers	or	between	
gleaners and aquaculture pond owners. 

4. Set of maps on aquaculture ponds: a range of maps covering a sub-set of data can be 
created, such as: a) production type (extensive or intensive); b) pond owner (commune, 
district, province, or outsider); c) pond contract holder (commune, district, province, 
or outsider); d) contract issued by commune, district, or provincial government; e) 
duration of contract; f) ponds under one contract holder; g) type of buyer of pond 
products (commune, district, province, or outsider); h) income level for pond; i) source 
of investment; j) permanent laborers per pond; k) female permanent laborers per pond; l) 
short-term laborers per pond; and m) female short-term laborers per pond.

5. Fishing by boat: a range of maps covering a sub-set of data can be created such as:  
a)	number	of	boats	per	owner;	b)	boat	power;	c)	number	of	fishing	nets	per	boat;	and	d)	
fish	catch	trend	per	boat.

6 Fishing by hand: a range of maps covering a sub-set of data can be created such as:  
a)	number	of	persons	fishing	in	a	given	area;	b)	catch	in	terms	of	kilogram	per	unit	of	time;	
and	c)	number	of	days	for	fishing	by	hand	per	month.

7. Clam farming: a range of maps covering a sub-set of data can be created such as: a) area 
of clam farm; b) contract issued by commune, district, or provincial government; c) number 
of share-owners in a clam farming company; and d) harvest level (unit per time period).

1.5 Key Resources Needed for Participatory Mapping

Before deciding on whether to carry out the participatory mapping, it is important to understand 
the range of resources needed to complete all the steps involved successfully. The following 
provides a good indication of the key resource components needed to carry out the participatory 
mapping work at the commune and district levels. 

1.5.1 People Resources

The process of participatory mapping is coordinated by a core technical team made up of a 
geographic information system (GIS) technician and a mapping facilitator. Each of these team 
members plays a distinct role: the GIS technician supports the design of the data collection 
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Figure 2: A digitized map showing the current condition and proposed rehabilitation areas for mangrove forests in 
Tien Lang District



process (including questionnaire design), the collection process itself, the processing and analysis 
of	data,	and	the	finalization	of	the	set	of	digitized	maps.	The	mapping	facilitator	helps	organize	
the key groups of people involved in each of the steps for preparation of the maps, particularly by 
training data collectors then ensuring the accuracy of data collected in the validation stage.

In addition to the core team, the local data collectors (local government staff and community 
members) will interview key resource users within the landscape and obtain answers for the 
questionnaire to link non-spatial data (e.g., management practices, type of contracts, production 
yield, etc.) to the spatial features (e.g., boundaries of shrimp ponds, locations of gleaning, etc.). It 
is	important	to	ensure	that	data	collectors	are	technically	proficient	and	understand	the	resource	
use issues within the coastal landscape. For this reason, it is useful to pair an older person, who 
has broad knowledge of coastal resources, with a younger person, who is usually more technically 
proficient	in	operating	technology	such	as	tablets.

1.5.2 Material Resources

There are two key types of material resources needed to undertake the participatory mapping 
process. One is concerned with the technical elements such as tablets, software, computers for 
processing GIS data, mobile projectors, and cameras. Another is related to the logistical elements 
of training data collectors, conducting data collection, and validating maps. To support this 
process, resources include arranging rooms for meetings and acquiring materials for facilitation, 
transport vehicles (motorbikes, boats, etc.) for data collection, bags for gear needed to collect 
data, and smaller items such as notebooks and pens.

1.5.3 Financial Resources

This is a critical element of project preparation. In addition to hiring the core team, the costs for 
hardware and software related to data collection and processing will form a large component of 
the total project cost. In addition, the costs for meeting rooms, training, data collection (including 
meals),	and	final	validation	workshops	will	all	need	to	be	factored	in	while	preparing	a	budget	for	
the participatory mapping work. 

1.5.4 Time Resources

If the commitment of the local government 
staff and key resource users is strong, then 
the process can be undertaken in a relatively 
short space of time. The key issue is 
determining	the	set	of	maps	needed	as	final	
products, and the time needed for training 
and data collection depending on the area to 
be covered by the maps. 

The next section sets out the step-by-step 
process needed to prepare the digitized 
maps for coastal spatial planning.

Data collector interviewing a gleaner during the 
participatory	mapping	data	collection	in	the	field.
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2. Step-by-Step Participatory Mapping
There	are	six	key	steps	involved	in	creating	the	identified	set	of	digitized	maps	(see	Figure	3).

These six steps involve:

Step 1: Preparation
Objective: To prepare the hardware, software, questionnaire, and base maps needed to carry out 
the participatory data collection.

Process: The	preparation	step	identifies	the	right	mobile	hardware	and	software	tools	to	help	
support data collection by local government staff and community members. Technical Appendix 
for Step 1: Preparation provides guidance on hardware (tablet and computer) and software 
selection for carrying out participatory mapping data collection and processing. In this guide, 
information is provided regarding the use of the application GeoODK (Open Data Kit) for data 
collection, two options to support GIS data processing and map creation (ArcGIS and QGIS), 
and a range of other software needed for questionnaire development, data aggregation, and data 
conversion. 

Once the hardware and software decisions have been made regarding the overall technical 
specification	of	the	system	for	data	collection,	processing,	and	representation,	the	next	step	is	
preparation of the questionnaire. Draft questions should be prepared in conjunction with key 

government	officials,	
mass organizations, and 
key types of resource 
users. This set of 
questions then needs 
to be converted into a 
questionnaire format 
appropriate for the 
software chosen to 
collect data. Technical 
Appendix for Step 1: 
Preparation provides 
guidance on how to 
prepare a questionnaire 
in Excel and then convert 
it into XForm for use in 
GeoODK. Training on use of GeoODK application in Tien Hung commune.

Figure 3: Step-by-step participatory mapping process



In conjunction with developing the questionnaire, decisions need to be made on how the area 
to	be	covered	will	be	divided	into	specific	survey	units	that	each	data	collection	team	will	cover.	
The Technical Appendix for Step 1: Preparation provides guidance on how to create sub-units 
in the form of spatial polygons for survey purposes. During the PCRA process, a paper map was 
created with key data on habitat types, resource types, risks, and infrastructure. These maps need 
to be digitized and integrated into the base map so that this preliminary information provides a 
contextual understanding for developing the set of detailed digitized maps. Technical Appendix for 
Step 1: Preparation	goes	through	the	specific	steps	needed	to	carry	out	this	conversion	of	data	
from paper map to digital map. 

Step 2: Training Data Collectors
Objective: To provide training to data collection team members who can include local 
government staff, members of mass organizations, and representatives of key resource user types 
in the commune’s coastal landscape. 

Process: All team members will receive training on how to use data collection equipment and 
how	to	carry	out	field	interviews	to	collect	the	data	necessary	for	preparing	the	maps.	The	
Technical Appendix for Step 2: Training Data Collectors sets out the training provided to team 
members on understanding how to use GeoODK applications to collect spatial and non-spatial 
information and how to administer the 
questionnaires	during	the	field	survey.	

Step 3: Field Survey
Objective: To	collect	data	efficiently	from	
field-based	interviews	that	will	be	used	to	
create	the	full	set	of	identified	maps.

Process: In order to ensure that there is 
complete coverage of the coastal landscape 
area of interest, it is important to carefully 
design the data collection process in 
terms of data collection team number and 
members. The Technical Appendix for Step 
3: Field Survey provides guidance on the key 
dimensions	of	field	survey	work	that	must	
be	identified	prior	to	the	commencement	of	
data collection.

Data collection in Tien Hung commune., Tien Lang 
district.
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Step 4: Data Processing
Objective: To	process	the	data	obtained	from	the	interviews	in	the	field	so	that	it	can	be	
analyzed and geospatially represented with the help of Excel and GIS software.

Process: Each	of	the	categories	of	data	identified	in	the	questionnaire	need	to	be	processed	and	
analyzed. The Technical Appendix for Step 4: Data Processing provides step-by-step information 
on how to process and analyze data in order to create a draft map for each of the key themes. 

Step 5: Map Finalization
Objective: To validate the contents of the full set of digitized maps created through the 
participatory mapping approach. 

Process: Although	maps	are	created	with	information	collected	in	the	field,	it	is	necessary	to	
validate the draft maps with those who helped to create them. Through workshops and, where 
necessary,	further	field	visits,	the	draft	maps	will	need	to	be	validated	so	they	can	be	finalized	
and used for a range of purposes including coastal spatial planning. Organizing workshops within 
each commune will involve presenting the maps organized by theme. The participants can then be 
divided	into	small	groups	to	work	on	validation	of	each	set	of	maps	on	specific	themes.	

Display of the range of digitized maps created from the participatory mapping process.



Once	revised,	they	can	be	provided	to	key	government	offices	and	local	leaders	for	further	use.	
These maps will also be used in the next step focused on developing spatial scenarios. This is 
covered in Guide No. 3: Building Coastal Spatial Scenarios in Vietnam: Supporting Planning in Coastal 
Landscapes at the Local Level. As needed, these maps can be updated over time so that they 
continue	to	accurately	reflect	the	details	of	the	local	coastal	landscape	resources,	users	and	
governance arrangements.

Maps	and	information	are	verified	through:

1. Field	visits:	The	project	GIS	specialist	returns	to	the	field	to	verify	any	unclear	location	and/
or information. 

2. Workshops/meetings: At least one meeting per commune and one workshop per district 
are needed. Workshop and group discussion meetings are held to validate and revise maps/
information both at district/commune level and with national/international experts. In these 
meetings: (1) participants are guided by the core technical team how to read the map, 
legend, and the information on the maps; and (2) participants should provide comments if 
they disagree with the map/information to ensure agreement on mapping revisions in each 
commune.

Once	the	maps	are	finalized	based	on	this	validation	process,	they	are	ready	for	dissemination	and	
use. A set of sample maps is provided in the section Sample Maps from the Participatory Mapping 
Approach in the appendices.

Step 6: Support for Using Maps
Objective:	To	strengthen	the	capacity	of	relevant	district	and	commune-level	offices	in	using	the	
maps and spatial data.

Group work to verify maps.
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Process: 

1. Develop a detailed guide to introduce list of outputs and data, as well as a step-by-step guide 
for basic functions.

2. Design a training program to provide basic knowledge and skills to implement the participatory 
mapping activities, to include:

a) General session

o A run-through of all processes and tools used in the project;

o List of project outputs and data;

o Instructions on how to access data and products; and

o Examples of how the data generated by the project can be used for management and 
decision-making purposes. 

b) Technical session (including guidelines, examples, and exercises):

o Installation of GeoODK on smartphones/tablets and QGIS software on laptops; 

o Examples of how to use GeoODK for data collection and develop basic questionnaires; 

o Exercise on basic functionality (e.g., importing, editing, updating spatial data, and 
preparing maps) in QGIS/ArcGIS; and

o Data management systems for project results.

A set of targeted trainees are selected from relevant agencies including the Province People’s 
Committee, District People’s Committee, Commune People’s Committees, Women’s Union, 
and other agencies based on the following criteria: (i) knowledge of tablet and computer use; (ii) 
willingness to learn new tools; and (iii) basic understanding and knowledge of GIS and mapping data.

Discussion of key issues and problem areas during data collection for 
participatory mapping.



3. Next Steps
Once	the	full	set	of	maps	has	been	finalized	and	made	available	to	key	local	stakeholders,	they	will	
be available for supporting a range of local needs. By training local map users in data collection, 
processing, and map creation, they will be able to update maps over time to continue to inform 
local-level planning and management needs. These maps can be used broadly to develop spatial 
scenarios	and	visions,	but	they	can	also	be	used	for	specific	projects	such	as	aquaculture	sector	
projections and planning or developing mangrove management approaches that involve zoning 
areas into older and younger mangrove forests and areas in need of rehabilitation.

The availability of geospatial data of this kind can spark interest in using them for emerging needs 
such as developing plans for ecotourism development, new infrastructure projects, or new clam-
farming areas at the commune and district levels. As such, this type of holistic and integrated 
information provides a platform for meeting a range of local needs and can be used to enhance 
provincial data collection. 

Aquaculture pond in Tien Lang district.
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Technical Appendices

Technical Appendix for Step I: Preparation
Part 1. Hardware

This part lists the necessary hardware equipment and provides recommendations.

A. Tablet as a tool for data collection

A tablet is a high-performance tool for data collection and recording with many advantages such 
as affordability (~$150/unit), minimum time required for data entry, support for diverse types of 
information/data, automatic transfer of data via wireless internet connections, and a user-friendly 
interface.	Survey	forms	can	be	designed	in	a	number	of	tablet	applications	and	can	include	fields	
for question-and-answer data as well as voice/video recording, photography, location coordinates, 
and time. The survey forms used in the Our Coast – Our Future project, and detailed here, were 
designed using the GeoODK application, which is only available on Android devices. 

When selecting a tablet for survey data collection, the following criteria must be considered:

• Operating System: Android.

• GPS function: GPS/GLONASS (Global Navigation Satellite System, to identify position 
without internet). If the tablet only has aGPS (assisted GPS) technology, a SIM card with 
3G/4G mobile network accessibility will be required.

• Screen: 5-inch display or larger.

• Camera.

• Storage: 16GB (gigabytes) or more.

• Availability for purchasing.

B.  Computer

A number of software programs and applications can be used to conduct the survey and spatial 
planning, including QGIS, ArcGIS, GeoODK, GeoODK Briefcase, GeoODK’s Mobile Data 
Conversion Kit, and Microsoft Excel (see details in the following section in this document). The 
selected computer must meet the following requirements to ensure smooth operation of the GIS 
software and display of high-resolution satellite imagery.



Recommended	specifications	for	a	computer	configuration	are	listed	below:

Specification Requirement
CPU speed 2.2 GHz minimum; Hyper-threading or 

Multi-core recommended
Platform x86 or x64 with SSE2 extensions
Memory/RAM Minimum: 4 GB

Recommended: 8 GB
Display properties 24-bit color depth

Also see Video/Graphics adapter 
requirements below.*

Screen resolution 1024x768 recommended minimum at normal 
size (96 dpi, dots per inch)

Disk space for software Minimum: 4 GB

Recommended: 6 GB or higher
*Video/graphics adapter 64 MB RAM minimum; 256 MB RAM or 

higher recommended. NVIDIA, ATI, and 
Intel chipsets supported

24-bit capable graphics accelerator

Be sure to use the latest available drivers.
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Part II. Software

This part lists the needed software packages and provides step-by-step instructions on how to 
install them.

A. GeoODK Collect for Android

Obtaining	a	field	survey	application	for	
collecting geo-referenced and non-
spatial information is a crucial step of this 
methodology. GeoODK (Figure 4) has been 
used	in	Vietnam	in	various	fields	of	natural	
resources management, for example in the 
forest monitoring system used for Payment 
for Ecosystem Services by the Vietnam Forest 
Development and Protection Fund. GeoODK 
is a freely available, open source application 
that allows users to collect and store georeferenced data, as well as a suite of tools to visualize, 
analyze, and manipulate ground-collected data.

Main functions in this project: 

• Collecting and storing geo-referenced data as well as non-spatial data.

Installation of the application (Figure 5):

Using Android tablet, open CH play > Search “GeoODK Collect” > Select Install > Select Accept

Figure 4: GeoODK icon

Figure 5: GeoODK Collect installation steps



B. ArcGIS

ArcGIS (Figure 6) is GIS software for working with maps and 
geographic information. It offers a wide set of tools for mapping, 
compiling geographic data, performing spatial analysis, data 
visualization, as well as data management solutions. ArcGIS is the 
most commonly used commercial GIS software.

ArcGIS is available for download at: http://www.esri.com/.

Main functions in this project:

• Create maps.

• Analyze mapping information.

• Support spatial planning.

Please be advised that the cost of ArcGIS could be high, but there are also free, open-source 
alternatives that can be used (see section for QGIS below). 

C. QGIS

QGIS (Figure 7) has been used widely in Vietnam for different applications, including disaster 
risk mapping, land use/land cover mapping, and forestry management. QGIS (Quantum GIS) is a 
cross-platform, free, and open-source desktop GIS application that supports viewing, editing, and 
analyzing geospatial data. QGIS supports both raster and vector layers in multiple GIS formats 
including	shapefiles,	coverages,	personal	geodatabases,	dxf,	MapInfo	to	PostGIS,	and	other	formats.	
As an open source application, QGIS features useful extensions which have been developed and 
updated regularly. QGIS integrates with other open-source GIS packages, including PostGIS, GRASS 
GIS, and MapServer.

QGIS is available for download at: http://www.qgis.org/en/site/.

Main functions in this project:

• Create maps.

• Analyze mapping information.

• Support spatial planning.

D. ODK Aggregate using Google Engine

ODK Aggregate provides a ready-to-deploy server and data repository to:

• Provide blank forms to ODK Collect/GeoODK Collect;

• Accept	finalized	forms	(submissions)	from	ODK	Collect	and	manage	collected	data;

• Visualize the collected data using maps and simple graphs;

• Export	data	(e.g.,	as	comma-separated	value	[CSV]	files	for	spreadsheets,	or	as	KML	files	for	
Google Earth); and

Figure	7:	QGIS	software	icon

Figure 6: ArcGIS icon by ESRI
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• Publish data to external systems (e.g., Google Spreadsheets or Google Fusion Tables).

ODK Aggregate can be deployed on Google’s App Engine, enabling users to quickly get running 
without facing the complexities of setting up their own scalable web service.

ODK Aggregate is available for download at: https://opendatakit.org/use/aggregate/.

Main functions in this project:

• Provide data storage.

• Visualize the collected data using maps and simple graphs.

E. ODK Briefcase

ODK Briefcase is a Java application developed to easily gather and aggregate data from ODK 
Collect without the need for internet connectivity. ODK Briefcase is also an alternative for those 
who do not want to setup an ODK Aggregate server or other ODK-compatible servers indicated 
above. ODK Briefcase can therefore either be a complementary tool to an ODK Aggregate server 
particularly during periods of poor internet connectivity or as a replacement for ODK Aggregate 
altogether. 

ODK Briefcase is available for download at: https://opendatakit.org/use/briefcase/. 

Main functions in this project: Export data to CSV format.

F. Mobile Data Conversion Kit

GeoODK’s Mobile Data Conversion Kit is a desktop application that aims to convert the CSV 
data from the ODK Aggregate system. Often there is a need to view the data in GIS software like 
ArcMap, QGIS, or Google Earth. This software will allow for the conversion of CSV exported data 
into a format that can be handled in the above GIS software programs. Also, this application can 
download images taken during the survey from the system.

Mobile Data Conversion Kit is available for download at: http://geoodk.com/downloads.html.

Main functions in this project: Convert	CSV	exported	data	to	Shapefile	and	KMZ	file.

G. Microsoft Excel

Microsoft	Excel	is	a	spreadsheet	program	included	in	the	Microsoft	Office	suite	of	applications.	
Excel spreadsheets present tables of values arranged in rows and columns that can be manipulated 
using both basic and complex arithmetic operations and functions. It features calculation, graphing 
tools, pivot tables, and a macro programming language called Visual Basic for Applications. 

Microsoft Excel is available for download at: http://www.webopedia.com/TERM/M/microsoft_excel.html.

Main functions in this project: Data analysis such as pivot table and calculation.

https://cloud.google.com/appengine/
https://opendatakit.org/use/aggregate/
https://opendatakit.org/use/briefcase/
http://geoodk.com/downloads.html
http://www.webopedia.com/TERM/M/microsoft_excel.html


Part III. Preparing the Field-Based Survey

Preparing	a	field	survey	for	collecting	geo-referenced	and	non-spatial	information	by	using	mobile	
tool	(tablet)	is	a	crucial	step	of	this	methodology.	A	field-based	questionnaire	is	created	within	a	
table	in	the	GeoODK	application.	Part	III	provides	details	on	how	to	create	a	field-based	survey,	
what application to use, and conversion tools.

A. Creating the 
Questionnaire 
Forms for GeoODK 
application

Forms	can	be	designed	first	with	Excel	
and then XLSForm will convert it to an 
XForm that can be used with GeoODK 
tools (Figure 8). XLSForm is a tool to 
simplify the creation of forms. We can 
convert	the	form	with	online	or	offline	
tools. 

A	sample	form	Excel	file	can	be	downloaded	
at: http://geoodk.com/xlsform_format.html.
Creating a questionnaire form involves 
the following steps: 

Step 1. Develop basic format of 
questionnaires in Excel

Figure 8: GeoODK form creation process

Figure 9: Three worksheets: survey, choices, settings
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Questionnaires are designed in an Excel workbook. Each workbook must have three worksheets: 
survey (questions), choices (answers), and settings (Figure 9). Each worksheet has a set of required 
columns	that	must	be	present	for	the	.xls	file	to	be	valid.	Additionally,	each	worksheet	has	a	set	of	
optional columns that allow further control over the behavior of each entry in the form, but are 
not	essential	to	the	specification.	Every	entry	must	have	values	for	each	necessary	column,	but	any	
of the optional columns may be left blank from entry to entry.

• Survey: This sheet will include all the survey questions, type of questions, label, and other 
instructions which ODK will interpret once the form has been uploaded (see Figure 10).

Column Description
type (required) ODK recognizes a set of question types, like 

single select (Yes or No questions), multi-
select, text, numbers, and even photos and 
geographical locations. You can also use 
grouped or repeated questions.

name (required) This column will be the headers for the 
responses. The name should be related to 
your question. Names should be unique and 
must not have spaces. Names may only have 
letters, numbers, and/or underscores.

label (required) This is basically how your survey questions will 
appear on your mobile device. You can type 
this in whichever format (e.g., “What is your 
name?”, “Age”, “Date today”).

hint As the name implies, this is where you can 
give your respondents a hint on how you want 
your question answered.

appearance This column determines how your question or 
groups of question will appear on your mobile 
device. Questions can be grouped together 
using	the	code	field-list	per	group	of	questions.

constraint This column is used to set restrictions for 
numerical questions. If you would like to have 
a minimum or maximum value of numerical 
answers, you can put in a constraint (i.e., >= 0 
and .<=1000).

constraint message If you have a constraint, this column allows you 
to show an error message if the responder 
fails to follow the constraint.



Column Description
relevance The entry in the ‘relevant’ column is a true or 

false XPath expression. When the expression 
evaluates to true, the question will be asked, 
otherwise it will be skipped.

required Put in Yes across the question which you want 
the respondent to answer.

calculation For questions requiring numerical answers, 
ODK gives you a chance to do calculations. 
${name_of_calculated_field}	is	the	expression	
used to perform a calculation. Under this 
column, you can request ODK to perform 
simple calculations for you.

Column Description
media You can also make questions that show the 

user	an	image,	a	video	or	an	audio	file	as	a	way	
of asking a question. In order to do this, you 
will need to put the media in /geoodk/forms/
formname-media folder on your phone, and 
reference	their	filenames	from	xlsform	in	a	
media column.

Figure 10: Required columns in “survey” worksheet
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Column Description
label It is easy to add multiple languages to a survey. 

You simply have to name your label::language1 
label::language2 etc., and your surveys will be 
available in multiple languages.

GeoODK Collect supports a number of simple question types: this type will be entered in “type” 
column.
Text Text input.
integer Integer (i.e., whole number) input.
decimal Decimal input.
select_one [options] Multiple choice question; only one answer can 

be selected.
select_multiple [options] Multiple choice question; multiple answers can 

be selected.
note Display a note on the screen, takes no input.
geopoint Collect GPS coordinates.
geoshape Collect Polygon coordinates.
image Take a photograph.
barcode Scan a barcode, requires the barcode scanner 

app is installed.
date Date input.
datetime Accepts a date and a time input.
audio Take an audio recording.
video Take a video recording.
calculate Perform a calculation; see “calculates” below.

• Choices: This sheet will include all the choices that will be used for single or multiple choice 
questions from your Survey sheet (see Figure 11).

Column Description
List_name (required) This serves the same purpose as your Type 

column in the survey sheet. This is your main 
reference in single-select or multiple-select 
questions in your survey sheet.

Name (required) This is similar to your Name column from 
the survey sheet. This must be unique and is 
related to your choices Labels. You can use 
letters, numbers, and/or underscores for the 
choices names.

Label (required) This shows how your choices will appear on 
your device.



• Settings: This sheet will determine how your sheet will be viewed in your mobile device 
(see Figure 12).

Column Description
form_title This is how the name of your form will appear 

in your form list.
form_id ODK creates an ID for each of the forms that 

you create. Make sure that your form_id is 
unique.

 

Figure 11: “Choices” worksheet
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Step 2. Convert Excel to XForm to be used in GeoODK 

To introduce the questionnaire forms into the GeoODK interface to be used on the tablet, the 
XForm should be converted from Excel format. This step can be done on a computer either 
online	(see	2.1	below)	or	offline	(see	2.2	below).

2.1. Convert Excel to XForm online

A computer with an active internet connection can convert the Excel form into an XForm 
online. To do so, please follow these steps (see Figure 13):

• Go to: http://geoodk.com/xlsform_converter.html. 

• Convert	to	XForm:	Select	“Convert	Excel	to	XLSForm”	>	Choose	the	Excel	file	>	Select	
Submit > Click Download to download Xform.

Figure 12: “Settings” worksheet

Figure 13: Open online conversion tool

http://geoodk.com/xlsform_converter.html


Figure	14:	Select	file	and	submit
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2.2	Convert	Excel	to	XForm	offline

A computer without an internet connection can convert the Excel form into an XForm with the 
correct software. To do so, please follow the steps in Figures 15 and 16.

Figure	15:	Offline	conversion	tool

Figure 16: Copy Xform into tablet



• Download	the	offline	converter	tool	at:	https://opendatakit.org/downloads/download-
info/xlsform-for-windows/.

• Extract	the	zip	file.

• Drag an XLSForm into xlsform.exe. A corresponding xform will appear in the output 
directory. 

• Xform in output folder is ready to use for GeoODK application.

Step 3. Copy Form to Tablet

Connect your tablet with the computer using a cable > Open tablet internal storage > Open 
“geoodk” folder > Copy the downloaded XForm to the “forms” folder within the “geoodk” folder 
(Figure 16).

B. Example Questionnaire Content
For the Our Coast – Our Future project, a questionnaire was developed to collect general 
information	and	specific	data	for	each	sector	on	coastal	resource	uses.	It	was	tested	during	the	
pilot survey and used in group discussion with commune members. Additional questions can be 
developed based on the needs and context. 

Sectors covered in the project were:

i. Aquaculture ponds;

ii.	 Farming	field;

iii. Fishing by boat near shore;

iv. Fishing by hand; and

v. Mangroves.

A sample list of questions is shown below:

Question Answer
General Information

Please select name of commune Select one:
 Tien Hung
 Dong Hung
 Vinh Quang
Please enter today’s date: Select date
Record the GPS point Record the GPS point 
Where is this location? Select one:
 Field
 Not	field
Choose the best descriptor of land use: Select one:
 Aquaculture ponds
 Farming	field
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Question Answer
 Fishing	capture	field	by	boat	near	shore
 Fishing	capture	field	by	hand
 Mangroves

Aquaculture Ponds
Please select the ID from map Type Polygon ID on map
What kind of production type is utilized 
in this pond?

Select one:

 Intensive Production
 Semi-intensive Production
 Extensive Production
Who is the contract holder of this pond? Select one:
 Commune Household
 Outside Commune Household
 Company
From whom do you contract the pond? Select one:
 Provincial government
 District government
 Commune government
 Company
 Household
Who is the primary owner of this pond? Select one:
 Provincial government
 District government
 Commune government
 Company

What kind of land use contract? Select one:
 Redbook
 Fixed Term Lease Contract 
How long is the contract Select one:
 50-year contract
 20-year contract
 10-year contract
 5-year contract
 2-year contract
 1-year contract
Date of contract signature? Type starting year
How many hectares? Type pond area (ha)
What kind of species are you farming? Multiple choices
 Shrimp
 Fish



Question Answer
 Crab
 Clam
What is the key production time frame 
for each species?

From month to month

Who will buy production from this pond? Multiple choices
 Company inside Province
 Company outside Province
 Individual buyer inside commune 
 Individual buyer outside commune 
Total annual investment in this pond? 
(million VND)

Type number

Total annual income from this pond? 
(million VND)

Type number

How many permanent laborers are 
involved in this aquaculture work?

Type number

How many women? Type number

How many short-term labor days are 
involved in this farming work?

Type number

What percentage of this is labor done by 
women?

Type number

Clam Farming
Field ID Type	field	id	from	list
Who	is	the	contract	holder	of	this	field? Select one:
 Commune Household
 Outside commune household
 Company
From whom you own or contract this 
field?

Select one:

 Provincial government
 District government
 Commune government
 Company
 Household
How many households are investing with 
you?

Type number

What kind of land use contract do you 
have?

Select one:

 Redbook
 Fixed term lease contract 
How long is the contract? Select one:
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Question Answer
 50 year contract
 20 year contract
 10 year contract
 5 year contract
 2 year contract
 1 year contract
Date of contract signature? Type starting year
How many hectares? Type pond area (ha)
What kind of aquatic species are you 
raising?

Multiple choices

 Shrimp
 Fish
 Crab
 Clam
What is the production period? From which month to which month
Who will buy the production? Multiple choices
 Company inside Province
 Company outside Province
 Individual buyer inside commune 
 Individual buyer outside commune 
Total annual investment in this 
production site? (million VND)

Type number

Total annual income from this 
production site? (million VND)

Type number

How many permanent laborers are 
involved in this farming work?

Type number

How many women? Type number
How many short-term labor days are 
involved in this farming work?

Type number

What % are women? Type number
Fishing by Boat Near Shore

Where do you come from? Select one:
 Commune Household
 Outside commune household
 Company
How many boats do you have? Type number
Total boat power? Type number (CV)
How	many	fishing	nets? Type number
What kind of species do you catch? Multiple choices
 Fish
 Shrimp



Question Answer
 Mix
Who	will	buy	your	fishing	catch? Multiple choices
 Company inside Province
 Company outside Province
 Individual buyer inside commune 
 Individual buyer outside commune 
Fish catch trend in recent years? Select one:
 More
 Less
What is the explanation for the trend? Type response
Total	number	of	fisher	laborers	involved? Type number
Number	of	fisher	women	laborers	
involved?

Type number

Fishing by Hand
Where do you come from? Select one:
 Commune Household
 Outside Commune Household
How	do	you	access	the	fishing	by	hand	
area?

Select one:

 Open access
 Limited access
 Forbidden access
What tools do you use for catching? Multiple choices
 Fix	fishing	net
 Fishnets
 Bamboo trap
 By hand
What	kind	of	fish	species	do	you	catch? Type
How	many	kg	of	fish	and	other	aquatic	
species do you catch per time?

Type number

Who	buys	your	fish	and	catch? Multiple choices
 Family consumer
 Individual buyer
How many days per month? Type number
How many members of your family are 
involved in this work?

Type number

Do you know how many people are 
catching with you in this area?

Type number

Mangroves
Who is assigned to protect this 
mangrove area?

Select one:
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Question Answer
 Household
 Coastal border guard
 Community
 Commune people’s committee team
What kind of protection contract? Select one:

Redbook
 Fixed term contract
How	long	is	the	fixed	term	contract? Type number in years
Contract signature date Type Date
What	are	your	benefits	from	this	
protection contract? 

Multiple choices

 Forest wood
 Protection fee
 Aqua product
 Honey bee
 Others
What types of mangrove species are 
present? 

Multiple choices

 Kandelia species
 Rhizophora species
 Sonneratia species
 Others
How high are they? Select one:
 Less than 2 m
 Greater than 2 m
When were mangroves planted? Select one:
 Less than 1 year ago
  1 - 5 year ago
  5 - 10 year ago
  10 - 20 year ago
 Greater than 20 year ago
Where are they located? Select one:
 Inside pond
 Outside pond
Do you think we should plant more 
mangroves in this area?

Select one:

 Yes
 No
Explain more  
Take a picture showing the landscape  



Part IV. Creating Survey Zones for Each Team

The entire area to 
be mapped is divided 
into separate survey 
zones,	identified	
with polygons in the 
digitized maps to be 
created. Each team 
covers a range of 
different survey zones. 
Each zone covers one 
type of land use, such 
as an aquaculture 
pond, a part of the 
mangrove forest, or a 
part	of	the	mud	flat.	
Using satellite images, 
areas of shrimp ponds 
and mangroves are 
digitized (a Google 
Earth satellite image 
is imported into 
GIS software and a 
polygon is manually 
drawn for each side of 
the shrimp pond and 
mangrove area) and a 
unique	identification	
number (ID) is 
allocated to each 
polygon shape in GIS 
software (Figure 18). 
The ID is important 
because after the survey is conducted, the ID for each polygon will be automatically linked to 
the survey interview form. See Figure 18 for an example of a diagram showing the survey zone 
polygons in Vinh Quang commune.

This zoning map with polygons is presented on a map and discussed with the data collectors 
during training. During the training, data collectors will decide how to allocate the survey zones 
amongst themselves and determine a suitable time for conducting the survey (depending on tidal 
patterns).	A	survey	plan	is	finalized	during	the	training.	

Figure	17:	Diagram	of	survey	zone	polygons,	Vinh	Quang	commune
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Data collectors are provided with 
a printout of the map in A1 size to 
support their survey process, and 
each survey group decides on the 
order for conducting the survey. 

How to get satellite images 
online:

It is possible to get high resolution 
satellite images with some GIS 
software (e.g., QGIS, ArcGIS). The 
software provides base maps as part 
of its map services. This requires an 
internet connection:

• In QGIS: Select Web > 
OpenLayer plugin > Google Maps > Google Satellite. 

Figure 18: ID for each polygon

Figure 19: Open satellite image in QGIS



Figure 20: Open basemap in ArcMap
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Part V. Converting the Participatory Maps Produced During the 
PCRA Workshops to GIS Format

The paper maps that were produced during the PCRA mapping exercise (See Guide No. 1: 
Participatory	Coastal	Resource	Assessment:	Developing	Commune	Coastal	Profiles	in	Vietnam) need to 
be digitized in GIS format (Figure 21). Additional spatial data such as updated forest inventory 
and infrastructure (e.g., settlements, sluice gates, dike systems, roads, and river channels) can be 
collected from the government and overlaid with the digitized information.

This spatial information forms the basis 
for creating maps that present the 
current status of local resources and 
will be used during the spatial planning 
process.

The maps of coastal resources should 
contain the following information:

• General features (such as roads, 
government buildings, sea dike, 
schools, religious buildings, and 
community halls) and administrative 
boundaries.

• Habitat areas: Mangroves (old 
forest), newly planted mangrove 
seedlings (new forest), seagrass, 
rocky	shoreline,	mudflats,	estuary,	
marine waters, boat passages and 
channels, and terrestrial areas.

• Resources:	These	are	specific	
resources harvested or grown in 
the different habitat areas. These 
can include aquaculture pond 
shrimp, open shrimp collection, 
crab	collection,	clams,	fish	species,	and	honey	production.	

• Resource	uses:	These	are	areas	allocated	for	specific	uses	such	as:	gleaning	areas,	fishing	
landing	or	gear	sites,	fish	drying	areas,	standing	fish	net	areas,	protected	areas,	sacred	areas,	
or rehabilitation areas.

• Issues/conflict	over	resources:	This	information	covers	issues	such	as	coastal	erosion,	
cyanide	fishing,	blast	fishing,	pollution,	weak	survival	of	mangrove	seedlings,	poor	production	
in	aquaculture	ponds,	heavy	storm	surge	damage,	and	conflict	over	resource	use.

Figure 21: One of the paper maps created during the Vinh 
Quang PCRA workshop



Technical Appendix for Step 2: Training Data Collectors
The training process is a combination of indoor (1.5 days) and outdoor (half day) exercises with 
intensive supervision by the core technical team. After the training and practical work, commune 
staff and active community members will have the necessary knowledge to use tablet applications 
and paper maps and collect data. 

Training Content
Expected results of the training:

• Collectors are capable of using GeoODK application for spatial and non-spatial data 
collection;

• Questionnaire contents are well understood by all collectors; and

• Collectors	are	able	to	facilitate	field	interviews	with	local	people.
Content:

• Preparation	for	field	surveys	(software,	hardware,	checklist	checking);

• Steps to use the GeoODK application for data collection;

• Questionnaire content;

• Development of survey plan; and

• Hands-on practice by using GeoODK to collect spatial and non-spatial information.

Part 1: Training on Questionnaire Content 
• Pre-test	the	questionnaires	(piloted	to	test):	The	survey	tool	is	finalized	after	a	test	pilot	in	
the	field.

• Guide	the	data	collectors	to	question	and	fill-in	questionnaires	in	GeoODK	from	the	
respondents by going through question-by-question. 

Part II: Develop Survey Plan for Each Type of Resource Users
Survey groups are formed and each group discusses the following issues for two land use 
categories within the survey plan: location, the best time for interview, tools to prepare, 
difficulties,	etc.	Survey	plans	should	be	presented	to	the	whole	group	to	get	feedback	and	
agreement.

Part III: Practicing 
a. Mini-game used in training: A mini-game should be used to test collectors on 

information presented in the training session (Figure 22).
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b. Indoor testing: Two groups practice with each other and take turns to give questions and 
answers within a half day, and the core technical team checks their results on the tablet.

c. Field testing: Groups can go out to practice for 2 hours; they should do 3 or 4 interviews 
and come back to the room to give their feedback. The core technical team should follow 
groups	in	the	field	to	observe	and	provide	guidance/support.

Figure 22: Mini-game used in training



Part IV: Field Survey Technique
When the training is completed, the following steps will be performed in the actual survey:

Step 1. Preparation before going to field

Hardware checklist: 

p   Tablet – touch screen is functioning and tablet is in working condition.

p 		GPS	–	make	sure	it	works	and	has	sufficient	accuracy/satellites	in	use	(Figure	23).

p   Camera – make sure camera application can take and save photos.

p   Battery and charger – make sure you have 75% of battery before you go out (3 hours 
coverage).

p   Storage – make sure there is minimum remaining storage of 3GB (Figure 24).

Software checklist:

p   Use the Android tablet.

p   See if GeoODK Collect application is installed on the tablet.

p 		Confirm	that	questionnaires	are	loaded	on	the	tablet.

p   Make sure you have the base paper map (optional).

Checklist for collectors:

p   Motorbike.

p 		Clothes	appropriate	for	fieldwork.

p   Raincoat, plastic bag for tablet.

p   Drinking water and some food.

p   Received from project: Two people will receive one set of these:

1. Tablet (need to sign it out) – inventory ID provided; name, address, and mobile phone are 
provided when signing tablet equipment out.

2. Paper map with survey diagram.

3. Paper list of ponds and interviewees, notebook, and bag to carry it all.

Step 2. Data collection in the field by GeoODK application using tablet

The example from our project survey is used below to show the order in which the survey steps 
are conducted. 
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Figure 23: GPS function check

Figure 24: Checking for remaining free storage



Figure 25: Select GeoODK application on the tablet screen

Figure 26: Select interview form
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Figure	27:	Change	language	settings

Figure 28: Select answer: one choice vs. multiple choice



Figure 29: Select date

Figure 30: Select type of land use or resource user, add polygon
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Figure 31: Add polygon ID

Figure 32: Add another polygon



Figure 33: Take picture

Figure 34: Record location
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Figure 35: Save form and exit



Technical Appendix for Step 3: Field Survey 
The survey team consists of two members. One member enters the survey information and 
asks clarifying questions during interviews. The other survey member, who should have a good 
understanding of the area and issues, can build trust during interviews. Survey teams should 
include:

• Young people (aged 20–35), who are often fast learners of new techniques/tools.

• Mid-aged people (aged 35–50), who tend to have a deeper understanding of the area and be 
familiar with interviewees. 

This helps simplify the interview process and assure the accuracy of entered survey information. 
If a shrimp pond owner is absent or not interested in being interviewed, this can be noted and a 
general visual interpretation can be done. Each group has a Group ID which can be entered in the 
questionnaire form. 

The core technical team and collectors should have a debrief meeting at the end of each day 
to review data collection progress, identify any challenges, discuss solutions, make necessary 
adjustments,	and	define	which	activities	need	to	be	prioritized.	

Data collection in the GeoODK application should follow the step-by-step process provided in 
the previous section on hardware checking, software checking, and checklist for collectors (see 
Technical Appendix for Step 2: Training Data Collectors).

The spatial survey is conducted with resource users using the tablet to supplement information 
collected during the PCRA process. The following data collection parameters are suggested:

• Sample size: 200 surveys/commune.

• Duration: 2–3 days/commune.

• Team: 6–9 teams/commune.
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Technical Appendix for Step 4: Data Processing  
Both non-spatial and spatial data collected during the survey need to be transferred from the 
GeoODK application to Excel format for further processing and analysis in Excel and GIS 
software	(ArcGIS	or	QGIS)	for	the	final	development	of	maps.	

Step 1: Export data from GeoODK to appropriate formats for 
processing in GIS software

1.1 Copy data in all tablets to only one GeoODK folder for each commune:

 It has the same structure as GeoODK in an Android tablet; the subfolders are:

• Form;

• Instances;

• Media; and

• Metadata.

1.2 Use ODK Briefcase to export data to *.CSV and media files

• Open ODK Briefcase v1.4.10.

• Set	up	result	folder:	Choose	Settings	tab	>	Select	location	for	exporting	files	(Figure	36).

Figure 36: Settings tab of ODK Briefcase



• Pull data from ODK Directory: Select Pull tab > Select Custom Path to ODK Directory > 

Choose ODK Directory > Select Form > Pull (Figure 37). 

• Export	data	to	CSV	file	and	media	files:	Select	Export	tab	>	Select	Form	>	Choose	export	
directory	>	Export:	(i)	Interview	result	CSV	file:	with	all	information;	(ii)	Polygon	CSV	file	
(Figure 38).

Figure	37:	Pull	tab	of	ODK	Briefcase

Figure 38: Export tab of ODK Briefcase
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Step 2: Data clean-up 
• Open	CSV	file	(*.csv)	in	Notepad,	save	as	to	a	text	file	(*.txt)	then	import	to	Excel	file	
(*.xlsx).	We	should	import	file	from	a	text	file	to	ensure	this	process	does	not	cause	any	
errors with Vietnamese text.

• Remove error interview results (missing Polygon ID, blank all information, etc.).

• Correct any errors.

• Each interview form receives a unique number in the database.

• Divide survey results into different tabs in the 
Excel workbook and save as *.csv for further 
processing (Figure 39).

o Aquaculture pond.

o Fishing by hand.

o Fishing by boat.

o Clam farming.

o Mangroves.

o Others.

Step 3: Example of processing data 
This section provides an example of processing survey data for different sectors surveyed in the 
Our Coast – Our Future project.

3.1 Aquaculture pond sector processing

• Join	Aquaculture	pond	ID	in	export	file	with	ID	in	Survey	Diagram	Shapefile	(or	other	type	
of	Polygon	file).

• Calculate	area	for	each	pond	using	survey	diagram	shapefile	in	ArcGIS/QGIS	software	>	
Export	to	Excel	file.

• Calculate pond area for each pond owner: use pivot table function in Excel to calculate in the 
exported	Excel	file.

• Calculate investment value for each ha/year.

• Calculate income value for each ha/year.

• Calculate number of labor/ha/year (permanent labor, short-term labor days).

• Calculate percentage of female labor (permanent labor, short-term labor days).

• Create	maps	with	ArcGIS/QGIS	based	on	Aquaculture	pond	shapefile	with	all	information:	
Base map: high resolution satellite imagery.

Figure	39:	CSV	result	files



• Use the Pivot table function in Excel to summarize results for each question/answer, for 
example:

o How many hectares are using intensive production type/extensive and farming 
intensive production type?

o How many hectares are managed by Commune/District/Provincial People’s 
Committee?

o How many hectares utilize a Fixed-term Contract/Red Book?

o Investment of pond: millions/ha/year.

o Income of pond: millions/ha/year.

3.2. Mangroves sector processing

Mangrove forests are already delineated in the existing data in the National Forest Inventory 
(updated every 5 years/cycle in the Vietnam context) and digitized based on high-resolution 
satellite imagery in QGIS or ArcGIS software. However, during the survey, additional spatial 
information is collected (e.g., new plantations that have not been shown in the satellite images). 
During	this	step,	all	new	information	is	merged	to	reflect	the	current	extent	of	the	mangrove	
forest.

Mangrove	forest	area/information	will	be	defined	from	different	sources:

• Digitized mangrove area based on high resolution satellite imagery (use OpenLayers Plugin/
Google Maps/Google Satellite in QGIS software).

• Updated National Forest Inventory data in 2016.

• Information	and	data	collected	from	the	survey:	Protection	Contract,	Benefit	from	
Protection Contract, Type of Mangrove Species, Height, and Year of Planting Work.

• Information from group discussion and exercise with satellite base map: Rehabilitation Area, 
Weak Survival of Mangroves, Seeding Area, and Year of Planting Work.

3.3. Fishing by boat/fishing by hand/clam farming/other sectors processing

Use	the	latitude	and	longitude	data	in	the	exported	CSV	file	to	create	shapefile	with	points	and	all	
information in ArcGIS/QGIS software.

• In	ArcGIS>	Select	File	>	Add	Data	>	Add	XY	Data	>	Select	CSV	file	>	Specify	latitude/
longitude	fields	>	Choose	Geographic	coordinate	system	GCS_WGS_1984	(Figure	40).
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Figure 40: Add XY data in ArcGIS

• In	QGIS:	Layer	>	Add	layer	>	Add	Delimited	Text	layer	>	Select	CSV	file	>	Select	file	format:	
CSV	>	select	X	field,	Y	field	columns	>	Choose	Geographic	Coordinate	System	GCS_
WGS_1984 (Figure 41).

Figure 41: Add delimited text layer in QGIS



Figure	42:	Add	CSV	file

Figure 43: Select coordinate reference system
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Step 4: Creating a map with ArcGIS/QGIS software
To visually present the results, all spatial data can be displayed on a map and printed for further 
use by the commune and district government.  

The following standard features should be present on the map:

• Title;

• Location frame;

• Scale;

• Legend;

• North orientation;

• Author(s)/Publisher(s)/Data source/Year of publication (if required); and

• Logo.

The map can be created using GIS software. An example of how to add these features on a map 
with ArcGIS/QGIS is shown below:

• With ArcGIS: select Insert to add (i) Data frame; (ii) text, (iii) legend, north arrow, scale bar, 
scale text, logo (Figure 44).

Figure 44: Add standard features to maps in ArcMap



• With QGIS: Add new print composer > add map and other features (Figure 45).

Maps exported to printable formats:

Maps can be exported to PDF, JPG, or any other picture format with minimum resolution of 220 
dpi for A3 paper or 300 dpi for A1 paper. Photography paper or normal paper are usually used for 
printing maps.

Figure 45: Add standard features to maps in QGIS
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Sample Maps from the Participatory Mapping Approach
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